
Japanese 

Verbs Demo
Welcome to Japanese Verbs! Japanese Verbs or JVerbs (as we usually refer to the program 
as) is a reference and a study program for the most common Japanese Verbs, their forms, 
and usage. 

To learn how to use Help press F1.

Differences in the Demo version

This is a working model of the program with the following limitations:

only 60 verbs
only 3 verb sets for the tutorials. 
the Verb Help is limited in various places. 

The real version has over 1000 verbs, 1200 example sentences with around 70 verb sets.

How to:

Overview
Getting Started
Verb Reference
Verb Tutorial
Alphabetical Index
Glossary

Commands:

File Menu
View Menu 
Search Menu
Tutor Menu
Help Menu

KiCompWare

JVerbs Pricing and Contacting
Other    Programs
Warranty



Overview
JVerbs (Japanese Verbs) is a Japanese verb reference and study program. JVerbs is useful for:

the beginner just starting to learn Japanese
the intermediate who occasionally feels more comfortable seeing romaji then 

hiragana or kanji, 
the advanced or expert who needs an occasional refresher on a particular verb. 

With JVerbs you can:

check out where the okurigana of a kanji stops and where the kana starts to appear.
display the verb in romaji, hiragana, katakana, or a kanji/hiragana normal form.
show the derivation of each verb
show one or more example sentences for each verb to aid in usage.
study the verbs using three kinds of flashcards, multiple choice and matching quizzes

and a game like tutorial.

JVerbs also has reference information on particles, adverbs,    and 
information on each inflection form. This information is available through the Verb Help 
under the Help Menu.

Most of the specific information on verbs is available under the Help menu from the Verb 
Help menu item. The reason for this is that Windows does not naturally display Japanese 
characters unless you resort to some tricks. Including Japanese text as pure bitmaps would 
greatly increase the size of this help file. 

NOTE
When possible the sentences are translated to use the general meaning of the Japanese 
verb in English. At times this makes the translated sentence somewhat awkward.

All Japanese sentences were created and verified by native Japanese speakers. There is a 
danger for non-native speakers of Japanese to create what seems to be a grammatically 
correct Japanese sentence, that no Japanese would ever utter. 

The forms, translations, and sentences given in this program should be taken to be generally
true. While we have marked verb forms that have the potential to be "ungrammatical", that 
does not mean they are one hundred percent "ungrammatical".    The following areas may 
give people problems, transitive and intransitve verbs, honorific and humble verb forms, and
the "give" verbs. While these areas are briefly touched on in the program, the program is not
meant to be a thorough Japanese reference (some of these topics also cause problems for 
native Japanese speakers!).



Getting Started with Japanese Verbs
JVerbs (Japanese Verbs) two functions are Verb Reference and Verb Tutorial. JVerbs can adjust
to your Japanese skill    level and can be further customized.

Go to one of these Help screens for more information

Application Window
Overview
Verb Reference
Verb Tutorial



Verb Reference

The Verb Reference side of Japanese Verbs provides a reference to over 1000 of the common
Japanese Verbs in daily use. The reference includes over 300 verbs such as,  
(kaimono suru, to go shopping) that use suru (

) for inflection. 

Use the Verb Index to quickly jump to the desired area. 
Narrow the verb list by using the Verbs to Show selection.
Use Find under the Search Menu to look for and then display the verb forms directly.
Use the Verb Help under the Help Menu for an on-line reference to many other 

aspects of the Japanese verb system and miscellaneous other information.    
Adjust JVerbs to your level at any time by using Skill Level from the File Menu. 
Customize what you see in each Verb Reference window (Verb Index, Verb List 

Window, or Verb Form Window) by    the Toolbar or menus and save it using the Custom 
selection in the    Skill Level    dialog box.

Use Setup Misc. to change the colors of various screen objects.

Note
Verbs are listed by their dictionary form. For instance, if you are looking for kaimasu (

), you would look or search for kau (
) and if you were looking for mimasu (

), you would look for miru (
). The verbs are listed in gojuuonban, or Japanese ordering. 

See Also

Find
Setup Misc
Skill Level 
Verbs to Show
Verb Index
Verb List Window
Verb Form Window



Verb Tutorial
The Japanese language is different from most other languages in that you must learn three 
different things for each word. To be able to read, write, comprehend, and speak Japanese, 
you must learn the kanji for a word, its yomikata, and the translation. JVerbs allows you, in, 
most cases, to adjust which relation you are trying to learn. JVerbs provides several different 
methods to help learn Japanese verbs. To familiarize yourself with the verbs, we suggest you
use:

Review
FlashCard K/Y/E
FlashCard 2. 

To test yourself on what you have learned, we suggest you use: 

Matching
MultiGuess
Moving Kanji

To practice or study your verb conjugations use:

Practice Endings
Review Endings.

If you would like to try an automated test sequence, use:

Tutorial Suite 

With the Tutorial Suite you may select all the Tutorials or only some Tutorials. The Tutorial 
Suite moves you to the next tutorial once you have completed the current tutorial.

The Tutor Setup dialog box is used to configure the tutorial before running it. The Completed 
dialog box gives you a chance to see any missed verbs, and then choose what to do next. 
The Tutorial Toolbar provides some command shortcuts and gives additional information on 
program status.

There are over 50 vocabulary sets provided with JVerbs and you can create you own sets 
using the Define Verb Set utility under the Tutorial Menu. To change a verb set that you have
defined, use Edit User Verb Set.

Go to one of these Help screens for more information.

FlashCard K/Y/E
FlashCard 2
Matching
Multiple Guess
Moving Kanji
Practice Endings
Review
Review Endings
Tutorial Suite

Define Verb Set



Edit User Verb Set
View Verb Set

Completed dialog box
Tutorial Toolbar
Tutor Setup dialog box



Application Window
The Application Window is divided into three major areas: Toolbar, Program Window, and 
StatusBar. 

Toolbar
The Toolbar contains controls for changing some program options. Most of these option are 
available through either the menus or dialog boxes via a menu selection. These command 
shortcuts are here to provide a convenient way to change relevant program options.

Program Window
The Program Window is where you will use most of the program functions. The verb 
reference functions and tutorials are displayed here.

Status Bar
The Status Bar displays information on what function the program is doing and shows brief 
help messages. It is divided into three areas: current window name, help message 1, and 
help message 2. 



Alphabetical Index
Acknowledgments
Application Window
Completed dialog box
Contacting KiCompWare
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Matching
Multiple Guess
Moving Kanji
Overview
Practice Endings
Review
Review Endings
Search Menu
Setup Misc
Skill Level
Technical Support
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Tutor Setup dialog box
Tutorial Suite
Tutorial Toolbar 
Verb Display Methods
Verb Form Toolbar
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Verb Help
Verb Index
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Verb Reference
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Verb Tutorial
View Menu 
View Verb Set



Glossary
Furigana
Hiragana
Inflection
Intransitive
Kanji
Katakana
Okurigana
Romaji
Transitive
Yomikata



Verb Index Window
The verbs in JVerbs are arranged in Japanese order (gojuuonban). Use a kana index 
button for faster access to a specific group of verbs. Press the All button to see the 
complete list of verbs. 

Use the Character Type Select radio buttons to temporarily change the keyboard 
index button character type. To make the change permanent, use the Skill Level 
Setup under the File Menu. 

The toolbar allows you to specify the Verbs to Show and whether or not to include 
the suru verbs.

See Also

Verb List Window 
Verb Form Window



Verbs to Show
All In Group

Show all verbs in that group. What is displayed depends on whether you pressed the All 
button, or an index button. To really see all the verbs in a group, you must also select with 
suru from the View menu or the Toolbar.

Beginner Verbs
 
Show only Beginner Verbs. The beginner verbs are the verbs that people just starting to 
learn Japanese learn. This list consists of almost two hundred verbs. In some respects, these 
verbs might be called the most common verbs. The Beginner verbs have two example 
sentences, one that uses simpler words and grammar and the other with no constraints.

Common Verbs

Show only the common verbs. The common verbs are the verbs that are used in everyday 
life in Japan. They do not contain highly technical or scientific verbs. To foreign speakers of 
Japanese, some of the common verbs may seem to be uncommon. It is also true that verbs 
that may be common to some Japanese are not necessarily common to all Japanese. The 
decision on what constitutes a common verbs is some what subjective and arbitrary.

Irregular Verbs

Show only irregular verbs. The irregular verbs are those verbs that exhibit stem changes 
that do not follow a pattern, or use entirely different forms for certain inflections.

Suru Verbs

Show the verbs that take suru. Japanese can not directly create a verb from a noun as 
English can. To make verbs from nouns, or from foreign loan words, the verb suru is used. 
Since these verbs are very regular, there is an option to omit these verbs from normal 
display using the with suru flag in the View menu or the toolbar. For this display option, that 
flag is ignored and all suru verbs are displayed for the selected group.

Transitive/Intransitive

Show the Transitive/Intransitive verb pairs. Probably one of the most troublesome areas of 
learning the Japanese verbs are these transitive and intransitive verbs. English really has no 
counterpart to this. To make matters more difficult, often at least part of the meaning of one 
of the pair has diverged from simply being a Intransitive form of the Transitive verb, and vice
versa. 

See Transitive/Intransitive in the Verb Help item under the Help Menu for a thorough 
explanation of the Transitive/Intransitive verb pairs.

UnCommon Verbs

Show only the uncommon verbs. What constitutes an uncommon verb is somewhat subject 
and arbitrary. It also could be said that these are    common uncommon verbs, as opposed to 
the really uncommon verbs.



With Suru 

With Suru determines whether or not the verbs that take suru are shown. There are 
two ways to change the status of With Suru, by the with Surucheck box, or the with
Suru menu item under the View menu. Check the check box or menu item to include 
the suru verbs. 



Verb Form Window
The Verb Form window has two screens, or pages. The first page shows the common 
inflected forms of the verb. The second page shows the verb with the auxiliary tenses 
(tenses which are themselves inflected), the honorific and humble forms, and the example 
usage sentence(s) for that verb. For verbs that have a intransitive or transitive counterpart, 
the counterpart is shown in the T/I Pair Verb Box in the lower middle of the screen (jump to 
the counterpart by double clicking in the Verb Box).

Grammatically questionable verb forms are shown Grayed (or in whatever color you select to
show Grayed items in). The honorific and humble forms given are the ones that foreigners 
will probably use. The Verbs Help has a list of other common irregular honorific and humble 
verb forms.

Click on the inflection title names (Plain Present, Plain Present, Provisional, etc.) to have the 
Verbs Help window popup with an explanation of that inflection.

Screen #1 Options: (Verb Form Page 1)

Use To
Inflection Title Call up the Verb Help System with an explanation of the inflection and 

example usage sentences.
 Show the inflected form (if hiden).

More Show the remainder of the inflected forms and example Japanese sentence(s) with 
translation. The button name changes to Back.
T/I Pair Verb Box Jump to the other verb in the transitive/intransitive pair. Double Click 
this box to jump to the other verb in the pair. Please note that the title and box are only 
shown when the current verb is part of an transitive/ intransitive verb pair. 

Screen #2 Options: (Verb Form Page 2)

Use To
Inflection Title Call up the Verb Help System with an explanation of the inflection and 

example usage sentences.
Back Return to the first screen. The button name reverts back to More.

 Show the inflected form (if hiden).
Kanji
Hiragana
Katakana
Romaji 
English Controls whether or not the sentence is shown in that form. There is a 

separate sentence for each of these items. (To save the configuration of 
these check buttons, select Skill Level under the File menu. Select Custom, 
then press the Save button.)

T/I Pair Verb Box Jump to the other verb in the transitive/intransitive pair. Double Click this 
box to jump to the other verb in the pair. Please note that the title and box 
are only shown when the current verb is part of an transitive/ intransitive 
verb pair. 



Scroll through sentences. This scrollbar only appears when there is more sentences 
to display than there is room in the Example window.

Scroll display long sentences. This scrollbar only appears when there are 
sentences that are too long to display on in the Example window.

Note
The colors of the sentences may be changed by using Setup Misc dialog box under the File 
menu. Using Setup Misc. you may also hide the questionable inflection forms. Which 
sentences are displayed, may be save by using the Skill Level dialog box.

There is a question whether the questionable forms (linguistically questionable) 
should be shown or not. If you ask two linguistic scientists, no doubt you will get 
different opinions. The fact is the forms can be created, and therefore at sometime, 
under some condition there is a chance that they may be used. At least one native 
speaker has the intuition that the verb is simply irregular in that form and uses a 
different verb to supply the form. The verb in question was the intransitive part of a 
transitive/intransitive pair.    

You will find that the intransitive verb of a transitive/intranstive pair (and those 
intransitive verbs with out a transitive counterpart) may have questionable forms for
imperative, volitional, potential, passive, causative, causative passive, honorific, and
humble inflections, or some combination. For this version of    the program, all the 
potential problem forms are marked for those verbs, that is, even if the forms are 
usable. Without extensive research and survey, an accurate explanation can not be 
given. Clearly there is something linguistically interesting going on here. 

See Also

Verb Form Toolbar
Verb Index
Verb List Window



Verb Form Toolbar
Options:

Use To
Index Return to the Verb Index Window.
List Return to the Verb List window.
Hide Hide all the inflection forms for the verb. (This is for people who would like 

to test their skills on the inflection forms.)
Character Set Select how to display the verbs in the Verb Form. The possible selections 

are: kanji, hiragana, katakana, romaji.
<< Show previous list of verbs, if any.
>> Show next list of verbs, if any.

Note 
The current configurations may be saved using the Skill Level under the File menu. Select 
Custom, then press the Save button.



Verb List Window
The Verb List window displays the list of verbs as chosen from the Index window. This can be
all the verbs, or a kana indexed selection, and is further limited by the group chosen in Verbs
to Show and whether or not with Suru is checked. The transitive/intransitive verbs are shown
in pairs, while the other groups are shown using the entire screen. 

Selecting a Verb    To select a verb for reference, position the mouse on a verb and 
click the left button. Click and hold the right mouse button on the verb and a 
window pops up with the verb listed in kanji, the yomikata of the verb follows on the 
next line, and the English translations of the verb follow below that. The yomikata is 
displayed in romaji if the Verb List window character set is romaji, otherwise the 
yomikata is displayed in hiragana.

Changing the Character Set    See Verb List Toolbar to change the character set.

See Also 

Verb Form Window
Verb Index
Verb List Toolbar



Verb List Toolbar
 
Options:

Use To
Index Return to the Verb Index Window
Verbs to Show Select which group of verbs to show. See also Verbs to Show
With Suru Select verbs that take suru. (See the Verbs to Show  Verbs to Show.)
Character Set Select how to display the verbs in the Verb List. The possible selections are:

kanji, hiragana, katakana, romaji.
<< Show previous list of verbs, if any.
>> Show next list of verbs, if any.

Note 
The current configurations may be saved using the Skill Level under the File menu. Select 
Custom,    then press the Save button.



Help Menu
Help Show context specific help.
Index Show the Help Index.
Getting Started Show information on quickly getting started.
Using Help Gives help on operating the Windows Help system.
Romaji -> Hiragana Show Romaji to Hiragana translation table.
Romaji -> Katakana Show Romaji to Katakana translation table.
Verb Help Bring up the verb help system.
About Show the About Window. 



Verb Help
MS-Windows as marketed for the U.S. market does not support the Japanese character set. 
To properly explain the Japanese Verbs system, the Japanese character set should be used. 
KiCompWare developed a special help system for this that looks and operates somewhat like
the Windows help system.

The verb help system contains additional information about Japanese Verbs, a description of 
each inflection with example explanatory sentences, and various other information. 

Use Verb Help under the Help menu to access this help system.



JVerbs Pricing and Contacting

JVerbs is priced at $99, with $5 shipping for U.S. and Canada. Shipping to all other countries 
is $10. Send check, money order, or Credit Card (MC, VISA) to below address.

KiCompWare welcomes your comments on Japanese Verbs. We do listen and respond to the 
needs of our customers. 
 

KiCompWare
P.O. Box 536
Appleton, WI    54912 USA
Phone: 612-773-8621
BBS: 612-779-0886
Compuserve: 101015, 206
 Internet:      101015.206@compuserve.com

Other    Programs



File Menu
Skill Level Show the Skill Level dialog box.
Misc. Setup Show the color and Fontpath configuration dialog box.
Exit Quit Japanese Verbs program.



View Menu
Index Show kana/romaji index
First Page Show first verb page
Select Page Jump to a specific page
Prev Page Show previous verb page (if any)
Next    Page Show next verb page (if any)

All Verbs Show all verbs
Common Verbs Show only the common verbs
Irregular Verbs Show only irregular verbs
Suru Verbs Show verbs that take suru
Trans/Intrans Show the Transitive/Intransitive verb pairs
UnCommon Verbs Show only the uncommon verbs
With Suru Include the verbs that take suru

See Also

 Verbs to Show



Misc. Setup

The Misc. Setup dialog box allows you to select colors for various parts of the JVerbs 
program. It also allows you to configure the Japanese font path.

To change the color of a selection, first select the button (click on that button), and next by 
moving the mouse cursor over the desired color on the upper right area of the dialog box 
and clicking the mouse button. If you select the same color for a character color as for a 
background color, that character will be invisible.    

Options:

Verb Reference Colors 

These selections only affect the Verb Reference areas of the program. 

Use To
Japanese Select the color for Japanese words (including romaji). 
English Select the color for English words. 
Highlight Select the color for the start of a kana (gojuuon junban) in the Verb List 

window.
Grayed
      check box Mark questionable forms with the color selected with the Grayed color 

button.    To hide questionable forms leave box unchecked.
Grayed Select the color for questionable forms in the Verb Form window.
Background Select the color for the background of the Verb Index and the Verb List 

windows only. 

Tutorial Colors

These selections affect all the tutorials. 

Use To
Kanji Select the color for kanji characters.
Yomikata Select the color for yomikata displays, whether in, hiragana, katakana, or 

romaji.
English Select the color for English translations. 
Background Select the color for the Moving Kanji window.

Example Sentence Colors

These selections affect only the example sentence in the Verb Form window.

Use To
Kanji Select the color for the sentence selected by the Kanji check button. 
Hiragana Select    the color for the sentence selected by the Hiragana check button. 



Katakana Select    the color for the sentence selected by the Katakana check button. 
Romaji Select    the color for the sentence selected by the Romaji check button. 
English Select    the color for the sentence selected by the English check button 

(the English translation).

Non-Joyo

Use To
no-Joyo
      check box Mark non-Joyo kanji with the color selected with the non-Joyo color button.
non-Joyo
    color button Select the color for the non-Joyo kanji. 

Buttons

Use To
Font Path Display the Font Path dialog box to change or view the current Japanese 

font path. (If you own a copy of MOKE 2.1, then changing the path to 
MOKE's \kanji path will allow you to delete the kijis16.fnt file supplied 
with JVerbs. This will save about 250k in hard disk space. )

Default Set all colors to the program default colors.
OK Temporarily change to the colors currently selected.
Save Permanently save changes made to colors or the Font Path.
Cancel Quit the dialog box without saving any changes.

See Also 

Skill Level
JVerbs.ini
FontPath



Font Path
The fontpath refers to the Japanese character font file. The font file is the same file as used 
by MOKE 2.1. If you have MOKE 2.1,    you can delete the font file "kijis16.fnt" in the JVerbs 
distribution and have JVerbs use the copy in MOKE's \kanji directory. Enter the correct 
volume and path for the font file in MOKE 2.1

Example:

 d:\kanji



JVerbs.ini
This file is created when JVerbs is first run after installation. The information in this file is in 
text format, but we recommend you use the Skill Level and Misc. Setup dialog boxes 
available under the File menu.



Skill Level

The possible selections are:

Beginner    JVerbs will display verbs using the romaji character set. This is the English-
like character set. Many people just starting out with Japanese use romaji, but they soon
advance to hiragana. 

Intermediate    JVerbs will display verbs using the hiragana character set.

Advanced    JVerbs will display verbs using    kanji when it can, otherwise it will display 
using hiragana. 

Custom    JVerbs will display the verbs using the character set and other options the way
you have them configured in each individual window. To do this, first go through JVerbs 
and configure each window as you like.    Next open the Skill Level dialog box,    select 
Custom, then press the Save button.

To change the skill level temporarily, select one of the three items (Beginner, Intermediate, 
or Advanced) in the list box and press the OK button. To make a permanent change, press 
the Save button. To make no changes, press the Cancel button. When you select Beginner, 
Intermediate, or Advanced, and press the OK or the Save button, various skill level options in
JVerbs will be changed automatically. When you select Custom and save, JVerbs saves the 
various skill level options the way you have them configured.

See Also 

Misc. Setup
JVerbs.ini



Verb Help Setup
The Verb Help Setup dialog box allows you to select the colors for kanji, yomikata, and 
English characters. 

To change the color of a selection, first select the button (click on that button), and next by 
moving the mouse cursor over the desired color on the upper right area of the dialog box 
and clicking the mouse button. If you select the same color for a character color as for a 
background color, that character will be invisible.    

Options:

Colors

Use To
Kanji Select the color for kanji characters.
Yomikata Select the color for yomikata displays, whether in, hiragana, katakana, or 

romaji.
English Select the color for English translations. 

Buttons

Use To
Default Set all colors to the program default colors.
OK Temporarily change to the colors currently selected.
Save Permanently save changes made to colors.
Cancel Quit the dialog box without saving any changes.

See Also 

JVerbs.ini
Misc. Setup
Skill Level



Search Menu
The Find functions may be used to jump directly to a verb reference. 

Find
Find Next



Find
Find a Japanese verb using Hiragana, Katakana, Romaji, or English. When searching for a 
verb using English, the translation portion of the entry is searched. The entire verb list is 
loaded for all searches. This includes all suru and all other verbs.

Find Options

Use To
Search Word Enter the verb to search for. This may be the entire verb or just a portion of

it.
Search Start the Search for the Search Word.
Cancel Exit the Find Verb dialog box with out searching.
Help Get Help on Using this dialog box.
Exact Search for the exact string entered as the Search word.    If Exact is not 

checked, all potential matches to the search string are found. This means if 
you search for to plan (or just plan),    JVerbs will find to plant as well. For 
Japanese, if you are searching for suru, all verbs that take suru will be 
found.

Search Options
        English Search for a verb using the translation portion of the verb entry. The status 

of the hiragana/katakana/romaji check buttons is ignored.
      Japanese Search for a verb using the yomikata of portion of the verb entry. Search for

the verb using hiragana, katakana, or romaji. The status of the 
hiragana/katakana/romaji check buttons determines which character set is 
used.

Romaji to Hiragana, and Romaji to Katakana tables may be displayed using the named items
in the Help Menu.

See Also 

Entering Hiragana/Katakana/Romaji
Find Next



Entering Hiragana/Katakana/Romaji

Hiragana is entered via romaji. That is, you use an ordinary ASCII keyboard and enter the 
romaji for the hiragana character. The hiragana input mode accepts only romaji. The 
hiragana for a romaji string is displayed when    the romaji unambiguously specifies a 
hiragana character. For instance, typing "a" yields " ", typing "k" displays the "k" on the 
input line. If "o" is pressed next, then "

" will be displayed on the screen.

The " " in "
" is ambiguous. Typing "n'" (n plus apostrophe) will yield "

" as will typing a space or the enter key. But normally you don't have to worry because as 
soon as what you have typed can be disambiguated, it will be displayed. For instance, in the 
word "

", typing "ho" yields "
". Next entering "n", leaves the "n" on the input line. After entering "d", the input line looks

as follows:
      nd
Entering "a" causes " " to be displayed.

However, there are two cases where you will generate incorrect Japanese. When there are 
double "n" as in "kantan ni". The conversion will generate erroneously " ". When there 
is a final syllable "n" followed by a kana starting with "y" in a word like "

" (
),    "nya" (

) will be generated rather than "n-ya" (
). Always using "n'" will eliminate these problems. 

 (small tsu) 

There are two ways to enter the " " in 
 or 
. 
 can be typed in as "shit-pai" or shippai and 
 can be typed in as "it-tara" or "ittara". Other double consonants supported are, "k" 

and "s". 

To type in all the small hiragana characters like:,    , 
, 
, 
, instead of their regular counterparts, 
,
,
,
 use x before the romaji. For instance, 
 is typed "xa" and 
 is typed "xya".

See the Romaji->Hiragana under the Help menu for mappings of all the romaji to hiragana 
conversions.



Tutor Menu
The Tutor Menu contains all the entries into the tutor system. Most of the tutor methods are 
self tests. The tutor vocabulary lists are derived from the list of verbs. There are over 50 
verb sets, and you can define your own sets. The tutor methods utilize the popular paper 
testing methods, matching, multiple guess, and a game like Moving Kanji.    To familiarize 
yourself with the contents of the vocabulary list, use the Review method.

Define Verb Set
Edit User Verb Set
View Verb Set

Tutorial Suite

Review
FlashCard K/Y/E
FLashCard 2
Review Endings

Matching
Multiple Guess
Moving Kanji
Practice Endings

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Tutorial Toolbar

Options:

Use To
Quit Quit current tutorial and return to Verb Index.
Setup Button Displays the Tutor Setup dialog box. Using the Tutor Setup you may select a

different verb set. See also the Setup dialog box section below.
Method Select one of six different tutorial methods.    The methods listed in pairs 

are: 1) Kanji/English, English/ Kanji, 2) Kanji/Yomikata, Yomikata/Kanji, 3) 
Yomikata/ English, English/Yomikata. For some tutorials, not all the methods
differ or make sense. For FlashCard 2, MultiGuess, and Moving Kanji 
tutorials all of these methods make sense, while only one method from 
each pair makes sense for Matching. For FlashCard K/Y/E only Kanji/English 
or English/Kanji make sense. (This combo box displays the possible 
inflections when Practice Endings or Review Endings have been selected.)    
Beginning students may just want to use Yomikata/English, or 
English/Yomikata.

Character Set Select the character set for yomikata, when a tutorial with a yomikata 
method is chosen.



Define Verb Set Window
This window operates much like the Verb List Window.

Done Button
Press this button when done to save the verb set, or to see which verbs you have 
already defined. 

See Also

Define Verb Set
Edit User Verb Set
Tutor Define
Verb Define Window



Save Defined Verb Set
The relevant information for the User Verb set being defined is displayed in this 
dialog box.

Options:

Use To
Verb Set Change the name of this verb set.
Description Describe this verb set.
Tutor Setup
 CharSet Select the character set to display the verbs in the Verbs Window 

(kanji/hiragana/katakana/romaji).
Save Save the new verb set to the tutor.usr file.
Continue Continue to select verbs for this verb set.
Cancel Quit defining this verb set. All information will be lost.
Help Get information on using this dialog box.
Delete Delete a verb or verbs in the Verbs Window. Highlight the verbs to delete in

the Verbs Window by clicking on them, then press the Delete button. 

See Also

Edit User Verb Set
Save Define Verb Set
Tutor Define
Verb Define Window



Completed Dialog Box
The Completed dialog box is displayed when a tutorial of a verb set has been completed. It 
has two forms, one for the FlashCard or Review type tutorials and the other for the Quiz type
tutorials. It gives you various options on how to continue, or to quit the tutorial. The 
FlashCard type Completed dialog box does not have the Completion Time or the Missed 
display and button.

Options:

Use To
Display Missed Open up a window and display the verbs that were missed.
Do Set Again Use the current verb set and do the tutorial again.
Do Next Set Do the next verb set with the same tutorial.
Change Setup Use the Tutor Setup dialog box to change the verb set, the method, or how 

to view the yomikata (hiragana, katakana, romaji).
Help Show this Help screen.
Quit Quit the tutorials and display the Verb Index.

Note
To clear best completion times for the quiz type tutorials delete the JVerbs.ini 
initialization file. When you do this, you will have to reset the other configuration 
variables.



Tutor Define Help
Use this selection to define your own Verb Tutorials. You might use it to remember 
the verbs that you have trouble with. Be sure to fill in the name and description 
fields so that you will find it easily the next time.

Options:

Use To
Name Name the verb set you are defining.
Description Short description of the verb set.
Define Start defining or selecting verbs for this new verb set. After pressing Define

the Verb Define Window will be displayed, select the Verbs, press the Done 
button, and Save the Verb Set by pressing the Save button in the Save 
Defined Verb Set    dialog box.

Cancel Do not make new verb set. Return to the Verb Index Window.
Help Show this Help screen.

See Also 

Save Defined Verb Set
Verb Define Window



Edit User Verb Help
Use this selection to make corrections or additions to your own Verb Tutorials. 

To delete a verb in the Verb Window, select the verb by clicking on it with the mouse, then 
press the Delete button. 

Options:

Use To
Verb Set Choose the Verb Set to Modify.
Description Short description of the verb set.
Tutor Setup
    CharSet Change character set used to display verbs in the Verbs Window. (kanji, 

hiragana, katakana, romaji).
Add Add verbs to this verb set.
Delete Delete a verb or verbs in the Verbs Window. Highlight the verbs to delete in

the Verbs Window by clicking on them, then press the Delete button.
Save Save changes to tutor.usr file.
Cancel Do not change the    verb set. Return to the Verb Index Window.
Help Shows this Help screen.

See Also

Define Verb Set
Define Verb Set Window



Tutorial Suite
 

The tutorial suite runs the selected tutorials in sequence on the selected verb set, 
automatically. Use this selection to drill yourself on a particular group of verbs. It is a good 
learning aid, because it forces you to use that verb set several times. Do one, two, three, or 
all of the tutorials. Use the mouse to check the ones you would like to do.

The Tutorial Suite is started by selecting the Tutorial Suite from the Tutorial menu. Choose 
the tutorials for this suite, then press the OK button. 

The tutorials are listed in two groups, the flashcard or review type tutorials, and the quiz or 
game type tutorials. The flashcard type tutorials are run first, followed by the quiz type 
tutorials. 

Flashcard type tutorials

Review
FlashCard K/Y/E
FLashCard 2
Review Endings

Quiz type tutorials

Matching
Multiple Guess
Moving Kanji
Practice Endings

During the tutorial suite the setup button will be absent from the Toolbar, and most of the 
menu items will be unusable. Use the Quit button to quit the tutorial.



View Verb Set
 
The View Verb Set command provides a direct way to browse through all the Vocabulary 
Sets. 

Options:

Use To
Verb Set Select a verb set (or to select    a verb set for the next tutorial).
Method Select one of six different tutorial methods.    The methods listed in 

pairs are: 1) Kanji/English, English/ Kanji, 2) Kanji/Yomikata, 
Yomikata/Kanji, 3) Yomikata/ English, English/Yomikata. For some 
tutorials, not all the methods differ or make sense. For FlashCard 2, 
MultiGuess, and Moving Kanji tutorials all of these methods make 
sense, while only one method from each pair makes sense for 
Matching. For FlashCard K/Y/E only Kanji/English or English/Kanji make 
sense. (This combo box displays the possible inflections when Practice 
Endings or Review Endings have been selected.)    Beginning students 
may just want to use Yomikata/English, or English/Yomikata.

Yomikata Charset Select the character set to use to display the yomikata (hiragana, 
katakana, or romaji).

Tutor Setup CharSet Select the character set to display the verbs in the Tutor Setup window 
(kanji,    hiragana, katakana, or romaji).

User Defined Use the user defined verbs rather than the predefined verb sets. When 
this button is pressed, User Defined Verb sets will be accessible. The 
button name changes to System Defined. Pressing the button again will
return the screen to System Defined Verb Sets and change the button 
back to User Defined.

Help Get information on how to use this dialog box.
OK Exit the View Verb Set dialog box.



Tutor Setup Dialog Box
The Tutor Setup dialog box allows you to select which verb set that you want to learn or 
review, and how you wish to review it.

Options: 

Use To
Verb Set Choose the verb set for the tutorial.
Method Select one of six different tutorial methods.    The methods listed in 

pairs are: 1) Kanji/English, English/ Kanji, 2) Kanji/Yomikata, 
Yomikata/Kanji, 3) Yomikata/ English, English/Yomikata. For some 
tutorials, not all the methods differ or make sense. For FlashCard 2, 
MultiGuess, and Moving Kanji tutorials all of these methods make 
sense, while only one method from each pair makes sense for 
Matching. For FlashCard K/Y/E only Kanji/English or English/Kanji make 
sense. (This combo box displays the possible inflections when Practice 
Endings or Review Endings have been selected.)    Beginning students 
may just want to use Yomikata/English, or English/Yomikata.

Yomikata Charset Select the character set to use to display the yomikata (hiragana, 
katakana, or romaji).

Tutor Setup CharSet Select the character set    to display the verbs in the Tutor Setup 
window (kanji, hiragana katakana, romaji).

User Defined Use the user defined verbs rather than the predefined verb sets. When 
this button is pressed, User Defined Verb sets will be accessible. The 
button name changes to System Defined. Pressing the button again will
return the screen to System Defined Verb Sets and change the button 
back to User Defined.

Help Get information on how to use this dialog box.
Go Start the tutorial
Cancel Cancel the tutorial

Note
The custom settings for the Yomikata Charset, Tutor Setup CharSet , and Method may be 
saved by using the Skill Level dialog box.



FlashCard K/Y/E
This FlashCard Window displays both the Yomikata and translation in sequence. Therefore 
the name, K/Y/E    (Kanji/Yomikata/English). This FlashCard Window is good for a new verb set
when you are not familiar with the vocabulary set. When you know are trying to learn a 
specific relation only, Kanji/Yomikata or English/Kanji for instances, use FlashCard 2.

The Japanese (kanji) is displayed at twice the normal size by default (kanji/English only). To 
display the Japanese at normal size, click on the Japanese and it will display at normal size. 
To display the enlarged Japanese again, simply click on it again. To permanently save the 
Japanese character size, use the Skill Level dialog box, and save as Custom.

Options:

Show the previous card

Show the next item

Show this card again (when all cards have been shown at least once.

Go to the next card 

Go to the previous card

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



FlashCard 2
This FlashCard Window displays two of the three items needed to learn a Japanese word. 
This FlashCard Window works well when you are trying to learn a specific relation only, 
Kanji/Yomikata or English/Kanji for instances. When working on a new verb set you may want
to use Review, or    FlashCard K/Y/E .

Options:

Show the previous card

Show the next item

Show this card again (when all cards have been shown at least once.

Go to the next card 

Go to the previous card

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Review
 
Review shows the word, its yomikata, and the translation all at once. Its purpose in life is to 
help you get familiar with the verbs in a set before going on to the tutorial quizzes. After 
finishing the review of the words try FlashCard K/Y/E, then FlashCard 2, Matching, and so 
forth.

The Japanese (kanji) is displayed at twice the normal size by default. To display the Japanese
at normal size, click on the Japanese and it will display at normal size. To display the 
enlarged Japanese again, simply click on it again. To permanently save the Japanese 
character size, use the Skill Level dialog box, and save as Custom.

Options:

Go to the next card 

Go to the previous card

 See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Matching
Matching is a common form of paper testing. For this tutorial you match a word on the right 
side of the screen with the best choice on the left side of the screen or vice versa. If the 
choices match, the buttons are grayed. If not, they remain highlighted. To display more 
information on a particular button, click on it using the right mouse button instead of the left
mouse button.

Right Button

Pressing the right button and holding it, while on one of the buttons will cause a window to 
pop up with additional English translations for the English buttons, yomikata for the kanji 
buttons, and kanji for the yomikata buttons. If a yomikata/kanji method is being used, then 
nothing is displayed (this might give the answer away!).

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



MultiGuess
MultiGuess, multiple guess, or multiple choice is a common form of paper testing. A word (or
phrase) is displayed on top with four possible answers (guesses or choices) below. Selecting 
the correct answer advances the screen to the next verb. To display more information on a 
particular button, click on it using the right mouse button instead of the left mouse button.

Right Button

Pressing the right button and holding it, while on one of the buttons will cause a window to 
pop up with additional English translations for the English buttons, yomikata for the kanji 
buttons, and kanji for the yomikata buttons. If a yomikata/kanji method is being used, then 
nothing is displayed (this might give the answer away!).

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Moving Kanji
Moving Kanji is a game like tutorial. A word (many times kanji) moves back and forth across 
a line near the bottom of the screen and buttons are displayed on the top. Matching the 
moving word with the correct button causes the button to disappear. If you click on a button 
that doesn't match the moving word changes. Don't worry, you'll get another chance at the 
word when you have gone through each word in the verb set at least once. To display more 
information on a particular button, click on it using the right mouse button instead of the left
mouse button (you can not get more information on the moving word).

Right Button

Pressing the right button and holding it, while on one of the buttons will cause a window to 
pop up with additional English translations for the English buttons, yomikata for the kanji 
buttons, and kanji for the yomikata buttons. If a yomikata/kanji method is being used, then 
nothing is displayed.

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Practice Endings
The Practice Endings tutorial gives you a chance to test your ability to inflect a Japanese 
verb with a particular inflection. The inflection being tested is selected in the Tutor Setup 
dialog box or on the toolbar of the Practice Endings window. A description of the commands 
follows.

Click on the [verb + inflection name]    to have the Verbs Help window popup with an 
explanation of that inflection.

Options:

Use To
Go to the next card. (Displayed only after the Give up button has been pressed.) 

Give up, show the answer and move to the next card.

Type in the inflected form of the verb in the Verb Input Window. If the inflection form is 
correct, a message will be displayed.    To go to the next verb    (if any), press the next-card 
button.    You will be given 4 tries to get the form correct. If you don't know the form, press

    (the give up button) and the answer will be displayed.

Note You may have to activate the Verb Input Window on some occasions. Do this by 
positioning the mouse on the Verb Input Window and clicking the left button.

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Review Endings
Review Endings is similar to Practice Endings and operates much like the Review FlashCard 
tutorial.    The endings of the selected inflection are shown. To advance to the next verb, 
press the next card button.

Click on the [verb + inflection name]    to have the Verbs Help window popup with an 
explanation of that inflection.

Options:

Use To
Go to the next card 

Go to the previous card

See Also

Completed dialog box
Tutor Setup dialog box
Tutorial Toolbar 



Hide Verb Forms
Upon entering the Verb Form Window, when    Hide Verb Form is checked, the inflected verb 
forms will be hidden by the  button. Pressing the button uncovers the inflected form.

Unchecking the Hide check button on the Verb Form Toolbar    will uncover all the inflected 
forms.



Furigana

The small hiragana that appears above the kanji. It is usually used for students just 
starting out in Japanese (including the Japanese grade school students). The main 
problem with using furigana is that students tend to read the furigana and tend not 
to remember the kanji. Regular Japanese text does not have furigana. 



Hiragana

One of the two kanas. Hiragana is used to write the Japanese words and to inflect 
Japanese verbs, put endings on adjectives, etc. Hiragana is characterized by more 
rounded and artistic strokes.



Inflection

A grammatical term used to describe the alteration of a word to indicate 
grammatical features such as tense, number, or person.



Intransitive

A term designating a verb that does not require a direct object. The Japanese word 
for Intransitive is jidoushi meaning self-moving. See Verb Help under the Help Menu 
for a more thorough explanation of Intransitive and Transitive.



Kanji

The Chinese characters used with the kanas to represent the Japanese Language. 
There are around 2000 basic kanji with an additional 5000+ other kanji. Some of the 
kanji were greatly simplified after W.W.II.



Katakana

One of the two kanas. Katakana is usually used to represent foreign words, but not 
always. It is characterized by straighter strokes.



Okurigana

The hiragana part of a verb or adjective showing inflection. The kana used to 
conjugate a verb or adjective.



Romaji

The method of writing Japanese with roman characters. It is highly ambiguous due to
the number of homonyms in the Japanese language.

Beginners usually prefer to see Japanese this way, while those more advanced prefer
to see real Japanese text (with kanji/hiragana/katakana)



Transitive

A term designating a verb that requires a direct object. The Japanese word for 
Transitive is tadoushi meaning other-moving. See Verb Help under the Help Menu for 
a more thorough explanation of Intransitive and Transitive.



Yomikata

Yomikata is the reading (or the pronunciation) of the kanji character(s). Kanji characters can 
have more than one yomikata and sometimes several yomikata. Usually a group of two or 
more kanji will have a single yomikata, but in some cases there is more than one way to 
read it. Many times if you have never seen the kanji word, you will not know how to 
pronounce it.



Other Programs
KiCompWare has created the products, 

MOKE A Japanese word processor for IBM PCs and compatibles.    
Kanji Guess (KG) A Kanji Learning program that tests you on vocabulary you enter.    
MagView A    Windows program that displays Japanese manga files.
ReadBook A Japanese Electronic Book Reader program. 

For more information on these products and other miscellaneous    programs/files write or 
call KiCompWare.

Contacting KiCompWare



Find Next
Find next occurrence of Search Word entered in Find dialog box.



Firstpage, Nextpage, Prevpage
Advance the screen to the First Page of the list, next page of the list, or the previous page of 
the Verb list.



Select Page
Use Select Page dialog box jump to desired page..



Help Index
Display Japanese Verbs Program Help Contents.



Using Help
Display windows help on running the Windows help system.



File - Exit
Exit Japanese Verb program and return control to windows.



Romaji -> Hiragana Table
Show Romaji to Hiragana conversion table. 



Romaji -> Katakana Table
Show Romaji to Katakana conversion table. 



Help - About
Shows the About Help Window.



Help - HELP
Shows context specific help. That is, help related to the specific area of the program 
that is currently being displayed.



Warranty
Japanese Verbs (JVerbs) is provided as is. KiCompWare disclaims all warranties, expressed or 
implied, including but not limited to, warranties of merchantability and of fitness of this 
program for any purpose. KiCompWare assumes no liability for damages direct or 
consequential; this includes, but is not limited to, the loss of profit or data, which may result 
from the use of this program.



Technical Support
Technical Support is provided via the KiCompWare BBS (612-779-0886), via KiCompWare's 
Yozakura BBS, or by postal mail. KiCompWare welcomes your suggestions for improving 
Japanese Verbs and its programs as well as bug reports.    When you contact KiCompWare 
with a problem, please include the following information so we can better assist you. 

JVerbs version number (see the About menu item under Help) and your registration number.

Your machine type (AT, 286, 386, 486), manufacturer and the configuration of your machine 
(additional cards, hard disk drive type and size,    keyboard, graphics adapter, etc.)

Version of MS-DOS
Version of Windows.

The contents of your config.sys file and autoexec.bat file.
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Define Verb Set
Select up to 20 different Verbs. This function works much the same as the Verb List window.  
However in this window you will not be able to see the verb forms or use the Verb Index. 
When through selecting verbs, use the Done button to bring up the Save Define Verb Set or 
the Edit Verb Set dialog box.

See Also 

Define Verb Set
Define Verb Set Window
Edit User Verb Set
Save Defined Verb Set





KG 1.0

KG or Kanji Guess is a program for aiding in the study of Japanese. KG can help those who 
are quite advanced.. While studying Japanese is a time consuming quest, KG tries to help 
reduce the time needed to learn individual words. Learning Japanese is complicated by 
having to learn Kanji (the chinese characters), their readings (the way they are pronounced),
and the translation of the Japanese to the native language. KG currently has several different
types of quizzes to help learn the associations between the kanji word, the reading, and the 
translation. KG 1.0 works with a mouse and is the recommended way of using KG, but 
keyboard commands are also available.

The KG quizzes are: kanji guess, flashcard, multiple guess, matching, Kanji Fish, and 
GojuuOnjun. KG works on IBM PCs or compatible (non
Japanese machines) and requires either a Hercules, EGA, or VGA    graphics monitor. 

Contact KiCompWare for pricing information.



MOKE 2.1

MOKE enables anyone with an IBM PC or compatible computer and a graphics monitor to 
enter Japanese. Japanese is entered via romaji. The kanas or Japanese syllabic characters 
are entered directly. When you enter a romaji representation (or yomikata) of a kanji, it is 
looked up in    the kana-to-kanji dictionary. The kana-to-kanji dictionary of some 25,000 line 
entries (more when subentries are also included) are frequency-ordered for fast searching. 
The dictionary includes everyday words, personal names, place names, and more.

MOKE features the ability to look up a word when the yomikata of only one of the kanji in the
word is known. Because of its on-screen lookup of the yomikata and English translations of 
Japanese words and its ability to add words to the initially small Japanese-to-English 
dictionary, MOKE can aid in the study of Japanese or in the translation of Japanese.

The newest feature in MOKE is the Nelson's like radical lookup. It is sure to be a hit with non-
Japanese users of MOKE

MOKE has utilities to print on Epson 9 and 24 pin compatible dot matrix printers, HP LaserJet
Series (including the DeskJet), and postscript printers.

Requirements:

IBM PC or compatible
IBM-compatible graphics monitor (CGA, EGA, VGA, or             Hercules)
Hard disk drive
Basic knowledge of the Japanese language

Contact KiCompWare for avalibility and pricing information.



MagView 0.6

MagView is a Windows    program for viewing .mag and .mki files. For best results you should 
have a VGA adapter capable of 256 colors at 640x480 resolution or better. It will work with 
16 colors, but windows will only give you dithered colors and not true colors. (.mag and .mki 
files use a 16 color palette not the same palette as windows provides). It also requires a 286 
or better (standard or enhance modes only).

Many of the Japanese BBSs have CG (Color Graphics?) archives with .mag or .mki files. 
Alternately check NiftyServe under Software Gallery Forum. Most of the files are manga of 
cute girls drawn by various people. Some are quite good. Some samples are included on the 
MagView disk.

MagView    is freeware, but not public domain. It may be available on some BBSes or directly 
from KiCompWare for $10 to cover shipping and handling.

MagView has the capability to save graphics file loaded into memory to either Windows BMP 
or PCX formats.

For More Information on Japanese Graphics Files See: 
 CG Art Collection, Amatoriasha 1991 Nov 25, ISBN4-87042-204-2, 1900 Yen



ReadBook 0.2

Read Book is a program that reads the 8 centimeter Denshi Book (or Electronic Book) CD-
ROM disks. Sony introduced the Data Discman in July 1990 in Japan and then in the US (and 
other countries?) in Fall 1991. Sony also manufacturers a CD-ROM drive that can be hooked 
up to many Japanese PCs. There are 2 or 3 third party vendors selling software to read the 
CD-ROM's much like the Data Discman can. 

ReadBook 0.2 is a very early release (read there are known minor bugs and could be major 
bugs in this program) and lacks many features that it    probably should have. ReadBook has 
been released in this form so we can get an idea of what interest there is in such a program 
and what kind of features those that are interested in it would like. The audience for this 
kind of program, while increasing everyday, pretty much relies on whether or not the PC that
they are using has a CD-ROM.    

ReadBook can read three Electronic Book CD-ROMs. They are: 

Kenkyusha's New Collegiate English-Japanese, and Japanese-English, 
Iwanami's Kojien, 
Sansyusya's English, Japanese, Spanish Electronic

Books. However, all the features of each Electronic Book have not been fully implemented 
yet. There are many EB titles available in Japan. The access methods very widely, almost 
requiring separate features, or at least a verification that a    Electronic Book Reader works 
with an individual title. That is the main reason why ReadBook, at first, works with a limited 
number of Electronic Books.

Additionally, not all Electronic Book titles are readable by all the CD-ROM drives and Data 
Discman readers. 

If there is sufficient interest, the program will be expanded to work with other such 
Electronic Book CD-ROMs.

Pricing
Shareware, but no charge until version 1.0
Avaliable on YoZakura and possibly other BBSes, or by mailing
$10 to KiCompWare. (one 360k disk)






